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Tomcat

m  Apache Jakarta (http://jakarta.apache.org/)
m Proyectos de herramientas Java (1999-2011)
= Ant, Commons, Gump, JMeter, Lucene, Maven, Struts, Tomcat, ...

m Tomcat es un contenedor de servlets

m Puede utilizarse como un servidor de aplicaciones Web con HTML,
servlets y JSPs

= O como complemento al servidor Apache
m Bien integrado en eclipse

m  Implementacidon de referencia para Java Server Pages (JSP) y
Java Server Faces (JSF)

m Pagina oficial: http://tomcat.apache.org/
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Arquitectura

m Servidor HTTP

m Contenedor de servlets
= Ejecuta serviets
= Convierte paginas JSP y JSF en servlets

m  Arquitectura jerarquica y modular:

Server
Service(s)
Engine(s) Catalina
Connector(s) Host(s) localhost
-HTTP
-HTTPS Context(s) docs, examples,
-AJP host-manager, manager, ROOT

(Applications or Webapps) \ ’

Figura de: http://www.ntu.edu.sg/home/ehchua/programming/howto/Tomcat_More.html
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Organizacion de directorios

m  bin — ejecutables y scripts de Tomcat

m conf — configuracién global para todas las aplicaciones

e catalina.policy — politicas de seguridad

= catalina.properties y logging.properties

* servlet.xml — fichero de configuracion principal de Tomcat

« web.xml — descriptores de despliegue de aplicacién web
context.xml — opciones de configuracién especificas de Tomcat
= tomcat-users.xml — base de datos de usuarios y passwords
= Un subdirectorio por cada engine y host. P.ej. Catalina/localhost

m lib — ficheros JAR disponibles para todas las aplicaciones web
= servlet-api.jar (Servlet), jasper.jar (JSP) y jasper-el.jar (EL)
= Drivers para bases de datos: MySQL JDBC driver (mysql-connector-java-
5.1.{xx}-bin.jar)
e JSTL (jstl.jar y standard.jar).

m logs — ficheros de logs
e Catalina.{yyyy-mm-dd}.log, localhost.{yyyy-mm-dd}.log, etc.

m  webapps — directorio base para las aplicaciones web
m  work — servlets y clases resultantes de traducir ficheros JSP y JSF
m  temp — ficheros temporales
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Aplicaciones Web con Tomcat

m Las aplicaciones Web constan de varias partes que se organizan
en varios directorios
m Directorio raiz de la aplicacion Web

e Ficheros HTML, JSP, CSS, JS, imagenes, etc. que son visibles a los
clientes de la aplicacion

= /WEB-INF/web.xml

e Web Application Deployment Descriptor

« Fichero XML que describe los servlets y otros componentes de la aplicacion,
ademas de parametros de inicializacion y restricciones de seguridad

n /WEB-INF/classes/

« Clases Java y recursos asociados: Servlets y no servlets que no estén
contenidos en ficheros JAR

= /WEB-INF/lib/
e Ficheros JAR: Librerias de clases, drivers JDBC, etc.

m Ademas hay librerias compartidas en el contenedor
= En $CATALINA_HOME/lib
- APIs Servlet 3.0 y JSP 2.1
e XML Parser conforme a JAXP para procesar documentos XML
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web.xml

<?xml version="1.0" encoding="1S0-8859-1"?>
<web-app xmlns="http://java.sun.com/xml/ns/j2ee"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemalocation="http://java.sun.com/xml/ns/j2ee/web-app_2_4.xsd"
version="2.4">

<servlet>
<servlet-name>Nombre del Servlet</servlet-name>
<servlet-class>es.ucm.cursoweb.MiServlet</servlet-class>
<init-param>
<param-name>parametro</param-name>
<param-value>valor</param-value>
</init-param>
</servlet>

<servlet-mapping>
<servlet-name>Nombre del Servlet</servlet-name>
<url-pattern>/saluda</url-pattern>
</servlet-mapping>

</web-app>
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Gestion de Tomcat

m La conexion al gestor de Tomcat se hace en la direccion
http://localhost:8080/manager/html

m  Hay que definir los usuarios que pueden gestionar Tomcat

m Los usuarios se definen con roles en el fichero
<tomcat>/conf/tomcat-users.xml

<?xml version='1.0' encoding="utf-8'?>
<tomcat-users>

<role rolename="tomcat"/>

<role rolename="manager-gui"/>

<user username="admin" password="passwd" roles="tomcat,manager-gui"/>
</tomcat-users>

m Para entrar habra que especificar el usuario (admin) con su password
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Gestor de Aplicaciones de Tomcat

€ > localhost:28080/manager/htrml (= i B- + El - tmanage P i =] b @

8. Apache
&

Software Foundation
http://www.apache.org/

Gestor de Aplicaciones Web de Tomcat

Mensaje: ‘OK ‘
Gestor
Listar Aplicaciones Ayuda HTML de Gestor Avyuda de Gestor Estado de Servidor
Aplicaciones
Trayectoria |Version Nombre a Mostrar Ej and Sesi C d
Arrancar [ Parar ] I Recargar ] [ Replegar ]
! Minguno especificade | Welcome to Tomeat true 0
sin trabajar = 30 minutos
Arrancar [ Parar ] [ Recargar ] [ Replegar ]
/docs Ninguno especificado | Tomcat Documentation true 0
sin trabajar = 30 minutos
Arrancar [ Parar ] l Recargar ] [ Replegar ]
[examples Ninguno especificado | Serviet and JSP Examples true 0
sin trabajar = 30 minutos
Arrancar [ Parar ] I Recargar ] [ Replegar ]
thost-manager |Minguno especificado |Tomcat Host Manager Application true 0
sin trabajar = 30 minutos
Arrancar Parar Recargar Replegar
Imanager Minguno especificade | Tomcat Manager Application true 1 - - _ _
sin trabajar = 30 minutos
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E.] New Server l = ﬂhJ
Define a New Server =
Choose the type of server to create

Download additicnal server adapters

Eclipse con Tomcat

m Instalar Eclipse J2EE

m  Anadir el servidor Select the server type:
type filter text
B Tomcatvdd Server -
B Tomecat v5.0 Server
E Tomcat v5.5 Server |
; R \\ .ri Tormcat vG.0 Server 3
(3) Hay que indicar “———= Tomcat v7.0 Server
la version que se 4 (& Basic
. . [l HTTP Preview i
tiene instalada de CHN!
Publishes and runs J2EE and Java EE Web projects and server configurations to a local
Tomcat Tomcat server,
Server's host name: g localhost
Server name: Tomcat v7.0 Server at localhost

-

|/_? )

Cancel

(1) Pestaina
Servers en la parte
inferior de eclipse

4L Servers B1

Mo servers available, Define a new server from the new server wizard..,

(2) Anadir servidor
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Eclipse con Tomcat

m Desde eclipse se puede arrancar y parar el servidor Tomcat
seleccionando el servidor y con las opciones del menu contextual

m Para probarlo, intentar acceder a http://localhost
m La primera vez lo normal es que salga un error 404

< Hay que copiar el contenido del directorio ROOT de apache-tomcat-

7.0.34\webapps en el correspondiente del workspace de eclipse:
workspace\.metadata\.plugins\org.eclipse.wst.server.core\tmpO\wtpwebapps

m  Un ejemplo para probar una primera aplicacion:

http://courses.coreservilets.com/Course-Materials/serviet+jsp-code/test-app.zip
m Descargarlo y luego desde eclipse probar File > Import > General »>
Existing Projects - Select archive file
m  Seleccionar el servidor Tomcat v7.0 y afadir test-app con "Add and
Remove" en el menu contextual

m Probarlo con http://localhost:8080/test-app/
que ofrece enlaces a otras paginas del ejemplo

Adaptado de: Tutorial: Installing Tomcat 7 and Using it with Eclipse
http://www.coreservlets.com/Apache-Tomcat-Tutorial/tomcat-7-with-eclipse.html
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Crear una aplicacion J2EE con Eclipse

m  Crear un nuevo proyecto
m File > New - Project > Web > Dynamic Web Project
e Para el "Target Runtime", elegir "Apache Tomcat v7.0"
e Dar un nombre al proyecto

- Aceptar las demas opciones por defecto y hacer Next dos veces hasta
la dltima pantalla del wizard

e Marcar entonces la casilla "Generate web.xml deployment descriptor"
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Organizacion de los ficheros de la aplicacion web

m Directorios de un proyecto de aplicacion web en eclipse
= WebContent

e Ficheros tipicos de web (HTML, JavaScript, CSS, JSP, imagenes, etc.)
e Aqui es habitual tener un fichero index.html o index.jsp

e Pueden organizarse en subdirectorios
= WebContent/WEB-INF
< web.xml — descriptor de despliegue

e Se puede omitir en servlet 3.0 apps, si se hacen los mappings de
servlet con las anotaciones @WebServlet en el cdédigo Java

= WebContent/WEB-INF/lib

« Ficheros JAR especificos de la aplicacion
m src/paquete

e Cddigo Java del paguete

e Para crear un paquete hacer New package en "Java Resources: src"
= Usar siempre paquetes. No es nada recomendable usar el default
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Alternativas a Tomcat

m Apache TomEE
m Adaptacion de Tomcat para integrar la funcionalidad de J2EE 6:
e Contexts and Dependency Injection (CDI)
e EJBs
= RESTful Web Service con JAX-RS

m  Glassfish
m Desarrollado por Sun (Oracle): https://glassfish.java.net/

m JBoss

m Incluye EJBs, programacién orientada a aspectos (AOP), servicio de
persistencia de objetos (Hibernate), gestién de caché, servicios de
mensajeria, etc.

= http://www.jboss.org

m WebLogic
= Servidor Web J2EE de Oracle
m  http://www.oracle.com/es/products/middleware/appserver/

m IBM WebSphere Application Server (WAS)
= http://www-03.ibm.com/software/products/es/es/appserv-was/
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Bibliografia

m Instalacién y configuracion de Tomcat con Eclipse
=  http://www.coreservlets.com/Apache-Tomcat-Tutorial

m Descripcion de Tomcat, arquitectura e implementacion

= http://www.ntu.edu.sg/home/ehchua/programming/howto/Tomcat_Mo
re.html

m Uso de eclipse y maven

m Jesus L.C. Configurar maven para hacer deploy en Tomcat, en
http://jesuslc.com/2013/04/08/358/

= How to create a Maven web app and deploy to Tomcat — fast
Added by Cody Burleson, last edited by Ben Shoemate on Jan 26, 2013

https://wiki.base22.com/display/btg/How+to+create+a+Maven+web+app-+and+deploy+to+Tomcat+-+fast
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Apéndice: Desarrollo con Tomcat y Maven

m  Prerrequisitos
= Maven esta instalado
m Tomcat esta instalado y configurado para correr en el puerto 8080
m Eclipse J2EE (opcional)

m Procedimiento
1. Crear una nueva aplicacion Web con Maven
Definir el servidor Tomcat en la configuracién de Maven
Apuntar el Pom al servidor Tomcat
Construir e implantar la aplicacion Web

P wN

Adaptado de: How to create a Maven web app and deploy to Tomcat — fast
Added by Cody Burleson, last edited by Ben Shoemate on Jan 26, 2013

https://wiki.base22.com/display/btg/How+to+create+a+Maven+web-+app+and+deploy+to+Tomcat+-+fast
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Apéndice: Desarrollo con Tomcat y Maven

1. Crear una nueva aplicacion Web usando Maven

m Si se usa Eclipse, crear un proyecto general
= New > Project... > General > Project
e Project name: "sw" (o cualquier otro nombre que se desee)

m Utilizando una consola, moverse al directorio del proyecto "sw" y
ejecutar el siguiente comando de Maven (en una sola linea):

mvn archetype:create
-DgroupId=es.ucm.sw
-DartifactId=webapp
-DarchetypeArtifactId=maven-archetype-webapp

4 |[= 5w
e Esto creard la estructura del proyecto 4 (= webapp
(para que Eclipse lo vea hacer Refresh) 4@ s
4 [=~ main
= resources
4 [= webapp
4 [ WEB-INF
1 web.xml
| index,jsp
) pom.xml
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Apéndice: Desarrollo con Tomcat y Maven

m El fichero index.jsp es el mas elemental que se pueda imaginar:

<html>
<body>
<h2>Hello World!</h2>
</body>
</html>

m Y el de configuracion de despliegue: web.xml

<IDOCTYPE web-app PUBLIC
"-//Sun Microsystems, Inc.//DTD Web Application 2.3//EN"
"http://java.sun.com/dtd/web-app_2_3.dtd" >

<web-app>
<display-name>Archetype Created Web Application</display-name>
</web-app>
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Apéndice: Desarrollo con Tomcat y Maven

2. Definir el servidor Tomcat en la configuracion de Maven

m Editar el fichero settings.xml de Maven

= Se puede ver en eclipse en Windows->preferences y una vez alli en
Maven->user settings

e La primera vez puede que no se encuentre el fichero settings.xml
e Se creara entonces
= Tras editarlo hacer Update settings

m En el fichero, afadir el servidor "TomcatServer" con los credenciales
para entrar como admin en el gestor de Tomcat

<settings>

<servers>

<server>
<id>TomcatServer</id>
<username>admin</username>
<password>passwd</password>

</server>

</servers>
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Apéndice: Desarrollo con Tomcat y Maven

3. Declarar en el Pom que se va a usar el servidor Tomcat

m Editar el fichero pom.xml del proyecto "sw" y reemplazar la
seccion <build> con lo siguiente:

<build>
<finalName>sw</finalName>
<plugins>
<plugin>
<groupId>org.codehaus.mojo</groupld>
<artifactId>tomcat-maven-plugin</artifactId>
<configuration>
<url>http://127.0.0.1:8080/manager</url>
<server>TomcatServer</server>
<path>/sw</path>
</configuration>
</plugin>
</plugins>
</build>
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Apéndice: Desarrollo con Tomcat y Maven

4. Construir e implantar la aplicacion Web

m En eclipse, seleccionar el pom.xml y hacer Run As-> Maven build
e indicar tomcat:deploy

m Alternativamente, desde la linea de comandos, ir al directorio
sw/webapp donde esta el pom y ejecutar

mvn tomcat:deploy

m Si el resultado es BUILD SUCCESSFUL se puede acceder a la
aplicacion web en http://localhost:8080/sw/

m Se tiene que ver el clasico "Hello World!" (de la pagina
index.jsp)

m A partir de aqui ya se puede construir otra aplicacion web

m NOTA: Si se intenta usar deploy otra vez dara FAIL porque la
aplicacion ya existe. Las siguientes veces habra que hacer:

mvn tomcat:redeploy
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